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1 Introduction 
The Community Development Financial Institutions (CDFI) Fund’s Awards Management Information 
System (AMIS) is an enterprise-wide awards management system that allows the CDFI Fund to manage 
the certifications and awards life-cycle processes without reliance on manual or paper-based methods. 
AMIS provides higher accuracy, transparency, and scalability to the CDFI Fund’s mission-critical 
processes across all CDFI Fund programs – CDFI, NACA, BEA, BGP, NMTC, CMF, and CDE and CDFI 
Certifications. AMIS runs on the Salesforce cloud-based application platform. As an external user, AMIS 
provides: 

 Standardized and common data elements to enable applicants and award/allocation recipients 
to use their information across programs 

 A consistent flow of information from applicants and award/allocation recipients to CDFI Fund 
staff, and vice versa 

 A portal where applicants and award/allocation recipients can: complete and submit 
applications online; submit requests for funding, amendments, and payments (disbursements) 
online; and submit compliance reports online 

 Interfaces with external and legacy systems, including Grants.gov, the System for Award 
Management (SAM), the Community Investment Impact System (CIIS), and the CDFI Fund 
Information and Mapping System (CIMS3). 

1.1 Purpose 

The purpose of this training manual is: 

 To provide detailed instructions and procedures for the CDFI Fund’s external users so that they 
may be able to navigate and use AMIS efficiently 

 To present training scenarios to aid trainees in learning how to use AMIS. 

1.2 Scope 

This training manual is an introduction to the overall features and navigation of AMIS.  Training on 
specific AMIS processes (e.g., applying for CDE Certification) is covered in other training manuals.  

2 Accessing AMIS 

2.1 Logging into AMIS – First Visit (for Users with Active AMIS Accounts) 

This section is targeted for users who have an active myCDFIFund account which was migrated to AMIS.  
If you have not registered for an AMIS user account and/or are new to working with the CDFI Fund, 
please see Section 2.2. 
 
Upon initial logon, you will be required to set your password: 

1. Navigate to: amis.cdfifund.gov. The AMIS Landing page displays.   
2. Click the LOGIN TO AMIS link.  

 
 
 
 

file:///C:/Users/sschneider/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/7Q0BEY2W/amis.cdfifund.gov
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Figure 1. AMIS Landing Page 

 
3. The AMIS Login page displays. Click the Forgot your password? link.  

 

 
Figure 2. AMIS Login Page – Forgot Password Link 
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4. After clicking on the link, you will be directed to a page where you will be prompted to enter 

your user name. Enter your user name.  Your user name is the email address you previously 
used for myCDFIFund.   

5. Click Submit. 
 

 
Figure 3. AMIS User Name Entry Page 

 
6. Once you submit your user name/email address, you should receive an email with a link to 

update your password.   
7. To reset your password, click the link provided in the email.  

 

 
 

Figure 4. AMIS User Registration Temporary Password 
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8. After clicking on the link, you will be directed to a browser page and will be prompted to enter a 
new password.  Enter your new password, verify, and click Save to log in to AMIS.  

 

Figure 5. AMIS User Password Change Screen 

 

 
9. Once logged in, you will be directed to the AMIS Home page.  

 

 

Figure 6. AMIS Home Page 

 

NOTE:  Passwords expire and must be reset every 60 days. Passwords must also 
adhere to the CDFI Fund’s password requirements: 

a. Be at least eight characters. 
b. Contain at least one lower case letter, one upper case letter, one number, and 

one special character. 
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2.2 Logging into AMIS – First Visit (for Users without an AMIS Account) 

If your organization is not registered in AMIS, you create a new organization in AMIS by going to the 
AMIS Login Page and selecting the “Join our Community” link. This will display the New User Registration 
page.  

 
Figure 7. AMIS New User Registration Page 

Enter your organization name, your first and last name, the Entity Identification Number (EIN) for your 
organization (never enter a Social Security Number in this field), and your email address. AMIS will 
create your organization in the system, and you will be added as an Admin User for that organization 
with your AMIS username being your email address. 
 
The first person to register with an organization becomes an administrator for the organization’s AMIS 
account and is automatically assigned the Admin User Profile by AMIS. Additional users who register 
under an organization are automatically assigned a Viewer Profile, with limited privileges. They can 

 

TIP: After you have established a user name and password, you can bookmark the 
Login page for future logins. 

 

NOTE: As with myCDFIFund, AMIS users may have associations with multiple 
organizations.  You have a unique User Profile (i.e., Admin User, User, or Viewer) for 
each of the organizations with which you are associated, granting you the 
appropriate access to each.  However, AMIS requires that each user have only one 
primary organization, meaning that a user can be an Admin User for only one 
organization.  To switch organizations in AMIS, simply click on the Organizations tab 
at the top of the screen.  If you need to change your type of User Profile for an 
organization, contact an administrator for that organization’s AMIS account. 

For more information about Organizations and User Profiles in AMIS, please see 
Section 6.4. 

https://amis.cdfifund.gov/CustCommunitiesLogin
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request additional privileges by contacting the administrator for their organization’s AMIS account. 
AMIS will automatically send an email notification to the administrator for the organization’s AMIS 
account informing them that a new user has registered under their organization.  

 
The administrator(s) for an organization’s AMIS account is/are responsible for setting up users in their 
organization and validating and assigning appropriate privileges to users registered under their 
organization.  

1. Users will receive an email with a user name and temporary password once they are registered.  
2. You will be directed to a page where you will be prompted to enter your user name. Enter your 

user name.  
  
 
 
 
 
 
 
 
 

 
Figure 8. AMIS User Name Entry Page 

 
3. Once you submit your user name, you should receive an email with a link to update your 

password.  See Section 2.1 above and follow Steps 7-9 to log in to AMIS. 

 

NOTE: The initial Admin User for an organization may grant Admin User privileges to 
other users within the same organization; as such, organizations may have more than 
one Admin User. 
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2.3 Logging into AMIS – Subsequent Visits 

Now that you have set your password and have logged into the system, you’re ready to do start doing 
your work within AMIS.  For future work within AMIS, you’ll access AMIS directly using your web 
browser. 

1. Navigate to: amis.cdfifund.gov. The AMIS Landing page displays.   
2. Click the LOGIN TO AMIS link. The AMIS Login page displays.  

 
 

Figure 9. AMIS Landing Page 

 
3. Enter your user name (i.e., email address) and password and click SIGN IN. 

file:///C:/Users/sschneider/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/7Q0BEY2W/amis.cdfifund.gov


AMIS Training Manual – AE101 
November 2016 

 
 

14 of 59 
 

 
Figure 10. AMIS Login Page 

 
4. You will be directed to the App Launcher page.  From the App Launcher, you can either: 

a) Navigate to AMIS, or 
b) Navigate to myCDFIFund to perform business with the CDFI Fund that is NOT currently in 

AMIS. 
 

 
Figure 11. AMIS App Launcher Page 

 
5. Click on the AMIS tile within the App Launcher.  You will be directed to the AMIS Home page.  
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Figure 12. AMIS Home Page 

2.4 Permissions and Security 

Each user will be assigned a User Profile in order to access AMIS. A User Profile determines the 
permission and privileges that a user will have. A user will be able to view, create, edit, and/or delete 
records for their organization based upon their User Profile. There are three profiles: 

 Admin User – This profile allows an administrator for the organization’s AMIS account to view, 
create, edit, and delete records in their organization. In addition, the Admin User is the only 
person allowed to assign the User Profile to other users registered under their organization.  
(Please refer to Section 6.4 Assign a Profile to a Contact (Admin Users only) for instructions on 
how to assign a profile to a contact.) 

 Viewer – This is the default profile automatically assigned by AMIS to all subsequent users who 
register under an existing organization. This profile has limited privileges and allows the user to 
view a limited set of organizational information. Such information includes organization type, 
address, and contacts. 

 User – This profile is assigned by the Admin User and allows the user to view, create, edit, and 
delete records in their organization. Such records include an organization’s financial 
information, contacts, applications, amendments, and compliance reports.  

2.5 Session Timeout 

AMIS logs out a user after two hours of inactivity. As such, it is very important to save your work 
frequently so that it is not lost. If you are logged out, access the Login page (see Section 2.3 above) to 
log in again to your AMIS account. 

2.6 Resetting Your Password 

AMIS disables your account after three failed login attempts. Before you are locked out of the system, 
click the Forgot your password? link, on the AMIS Login page, and follow the on-screen instructions to 
reset your password. If your account becomes disabled, contact an administrator for your organization’s 
AMIS account.  
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Figure 13. AMIS Login Page – Forgot Password Link  

3 User Profile 
The menu items under your name, in the top right corner, give you access to your User Profile where 
you can edit your personal information and customize AMIS to look the way you like.  

 
Figure 14. AMIS User Profile 

 
In this section, you will learn how to: 

 Manage your settings 

 Change your password 

 Change your user name 

 Set up/change reminders and alerts 

 Log out of AMIS. 

3.1 Manage Your Settings 

My Settings allows you to change many settings that include the appearance of your AMIS web pages to 
suit your personal preferences. Click your name, from the top right corner and select the My Settings 
option. 
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Figure 15. AMIS My Settings Page 

 

 

NOTE: Please note that this training manual focuses only on the frequent 
User Profile settings essential to perform your day-to-day work in AMIS. 
Future versions of this document may detail the other settings available to 
external users, as needed. 

3.2 Change Your Password 

To change your password: 

1. Click the Security Settings link from the My Settings page. You will be forwarded to the Security 
Settings page where you can change your password.  

 
Figure 16. Security Settings Page 

2. Complete the information on the page. 
a. You are required to enter your current password before changing it. 
b. You may move the mouse over the Information icon to see the format required for the 

password. 
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NOTE: A required field has a red highlight and is mandatory to save 
information on a page. For example, Current Password is a required field. 

3. Click the Save button to save your changes. 

3.3 Change Your User Name 

To change your user name: 

1. Click the Security Settings link from the My Settings page. 

 
Figure 17. Security Settings Page 

2. Click the Change User Name link on the Security Settings page. 

 
Figure 18. Change My User Name Screen 

3. Update your user name.  
4. You are required to provide your current password in order to change your user name. Enter 

your password. 
5. Click the Save button to save your changes. 

3.4 Set Up/Change Reminders and Alerts 

The reminders and alerts feature allows you to set up or change reminders and alerts for your events 
and tasks. (Reminders and alerts are connected to the Manage My Tasks and Calendar Events on the 
AMIS Home page. Please see Section 4.1 for more details on managing tasks and using the calendar.)  To 
set up or change your reminders and alerts:  

1. Click the Reminders and Alerts link from the My Settings page. 
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Figure 19. Reminders and Alerts Page 

2. Change the settings, as needed. 
3. Click the Save button to save your changes. 

3.5 Log Out of AMIS 

To log out of AMIS, click your name in the top right corner, and select Logout. 
 

 
Figure 20. AMIS Logout Screen 

4 Overview of the Home Page 
The AMIS Home page gives you instant access to your  information in AMIS. It consolidates all your work 
and activities in one section. After you log in to AMIS, the AMIS Home page is displayed, if it is your 
default home page. Click on the Home tab to ensure you are on your Home page. From the Home page, 
you can: 

 View/manage your tasks 

 View calendar events 

 Use the sidebar  

 Access other tabs. 
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Figure 21. AMIS Home Page 

4.1 View/Manage Your Tasks 

The My Tasks section displays your pending work. It includes work that your colleagues, such as your 
manager, have assigned to you or follow-up work that you have initiated and want to track. You can use 
this feature to keep track of your upcoming deadlines or deliverables. For example, you can set up tasks 
to: 

 Complete an application 

 Complete matching funds during the specified timeframe 

 Complete compliance reports 

 Request subsequent payments (disbursements). 

My Tasks also has a feature to filter your work using the drop-down menu on the right side of the page 
so that you can prioritize your work. For example, you can filter for All Open tasks or Overdue tasks by 
selecting that option from the drop-down menu. 
 

 
Figure 22. My Tasks Screen 

4.1.1 Create a New Task 

1. Click the New button under My Tasks. 
a. The Assigned To field is required and defaults to your name. You can assign this task to 

another user by clicking the Lookup icon next to this field and searching for the name of 
the assignee. 
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b. Subject is a required field. 
 

 

Figure 23. Task Edit Page 

2. Enter a subject, due date, and comments. For example, if you wish to set up a task to complete 
your compliance report, then: 

a. Enter the subject as “Complete Compliance Report.” 
b. Enter a due date. 
c. Enter instructions in the Comments field. 

3. Use the Related To field if you wish to link a task to a record, such as an award or compliance 
report record, in AMIS. 

4. Use the Status field to track the progress of the task; when creating a new task, leave the default 
value of “Not Started”. 

5. Use the Priority field to indicate the priority of the task. 
6. The Phone and Email fields are non-editable because you do not need to enter information in 

those fields. 
7. Click the Save button to save your information and view the task. Note: Tasks that you have 

assigned to other colleagues will not be displayed on your My Tasks list. Instead, they will be 
displayed in the My Tasks list of the assignee. 

4.1.2 View/Update a Task 

You can use this feature if you want to view the details of a task or update the status of a task. 

1. From the My Tasks list, click the Subject to open a task and view the details (e.g., click the 
subject of the task you created above). 
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Figure 24. Task Detail Page 

2. Click the Edit button to be forwarded to the Task Edit page.  
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Figure 25. Task Edit Page 

 

3. Update the Status to “Completed”. 
4. Click the Save button to save your changes. 

 

TIP: As a best practice, always update the status of a task so that you and 
your colleagues can track the progress in real-time. 

4.2 View Calendar Events  

The calendar allows you to view events and meetings that CDFI Fund staff have scheduled with your 
organization so that you can track upcoming events and plan your work week. CDFI Fund staff will send 
meeting invitations to organizations they wish to meet with. Note: The calendar is a view-only feature 
for external users.  
 

 
Figure 26. AMIS Calendar Events 

Click on the Event Subject to view the calendar event details. 
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Figure 27. Calendar Event Detail Screen 

4.3 Use the Sidebar  

The sidebar appears on the left on most AMIS pages with multiple components that improve usability. 
These components provide convenient access to: 

 Create new records (e.g., tasks and service requests) 

 Open your recently viewed items 

 View important messages and alerts, if any 

 Open custom links, if any. 

 

Figure 28. Sidebar Components 

 
The sidebar can be: 

 Collapsed to increase working space by clicking the Left arrow. 

 Expanded by clicking the Right arrow. 
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5 Tabs, Objects, and Records 
Information in AMIS is organized into objects and records. Each object is a category of records and 
contains different information. Each record details a specific piece of information. In the example shown 
below, a FY15 NACA Award is a record; award records “reside” within the Awards object. 
 

 
Figure 29. Records and Objects    Figure 30. Award Record and Object 

 
A tab allows you to access data related to a specific object. Tabs are displayed across the top of all pages 
in AMIS; they are the primary means of accessing records. For example, the Organizations tab allows 
you to view organization-related records and the Awards tab allows you to view award records. 
 
Click the Organizations tab to view data on your organization. 
 

 
Figure 31. Organizations Home Page 

 
From within each tab, you can: 

 Access existing lists of a record 

 Create or edit a record 

 View details of a record 

 Do in-line editing of a record 

 Delete a record (with the necessary permission) 

 Use shortcuts to access related lists of a record quickly 

 View related lists of a record. 

5.1 Access Existing Lists of a Record 

A list of your Recently Viewed records is displayed when you click a tab. This is the default Salesforce 
behavior. You can change the filter and instead view your Recently Created or Recently Modified 
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records. In most instances, you will have one record for your organization under the Organizations tab. 
However, under other tabs such as Service Requests or Awards, you will see multiple records if you have 
created multiple service requests or have received more than one award. 
 

 
Figure 32. Recently Created, Modified, and Viewed Filters 

 
You can also access customized list views with specific customized columns by selecting an option next 
to the View drop-down menu. Select All Organizations and click the Go! button. 
 

 
Figure 33. All Organizations View 

 
The list view allows you to edit a record, delete a record (with the appropriate permission), and access 
the Detail page. Clicking on the Edit link under the Action column brings up the Organization Edit page. 
Clicking on the Organization Name brings up the Organization Detail page.  As noted above, in most 
instances, you will see one record in the All Organizations list view because the majority of external 
users are registered under one organization only. 
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Figure 34. Organizations List View 

 

5.2 Create/Edit a Record 

Creating records is the standard procedure to be used to enter data into AMIS. Users can only create 
new records or edit existing records if they have the necessary permission granted to them by an 
administrator for their organization’s AMIS account.  
 
To create a new record, you typically click the New button for the record you want to create. However, 
for organizations, AMIS automatically creates an Organization Profile once your organization is 
registered. The Organization Profile created automatically by AMIS contains partial information; an 
authorized user from the organization must complete all the required information. (Please see Section 9 
for more information on Organization Profiles.) In this section, you will learn how to edit a record by 
editing the organization record. 
 
To edit your organization record: 

1. Click the Edit link displayed next to your organization. 
Note: If you do not see an Edit link, you may not have the permission to create and edit records. 
Please contact an administrator for your organization’s AMIS account, if you require these 
capabilities. 
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Figure 35. Organization Edit Page 

2. Enter all the required information on the page – a required field has a red highlight and is 
mandatory to save information on a page. For example, Organization Name is a required field. 

 

Figure 36. Organization Edit Page – Required Information 

3. Notice the Field-Level Help link displayed as an Information icon to the right of the Organization 
Structure field. These links provide instructions about a particular field on the page. For 
example, Organization Structure has a Field-Level Help link that explains that the field is 
dependent on the selected Financial Institution Type.  
 
Move the mouse over the Information icon (Field-Level Help link) to see the instructions. 
 

 

Figure 37. AMIS Field-Level Help Link (Information Icon) 

4. Notice the multi-select drop-down menus; the multi-select menus allow you to choose multiple 
values for a field: 

a. Scroll down the page to the Special Targeted Areas field. 
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b. Add a value from the Available list by selecting the desired value and clicking the Right 
arrow. 

c. Remove a value from the Chosen list by selecting the desired value and clicking the Left 
arrow. 

 

Figure 38. Adding/Removing Values 

5. Complete all other fields on the page. 
6. Save the record by clicking the Save button: 

a. The Save buttons are located at the top and bottom of the page for your convenience. 

 

Figure 39. Save Buttons 

b. Clicking the Save button on any Edit page saves the record and forwards you to the 
Detail page which is not editable. 

c. Clicking the Save & New button on any Edit page saves the record and re-displays 
another blank form to create a new record. Use this button when you want to create 
several records quickly. 

d. Clicking the Cancel button allows you to cancel the action. 

5.3 View Details of a Record  

The Detail page allows you to view the details of a record. To access the Detail page: 
 

1. Click the Organizations tab to ensure you are on the Organizations Home page. 
2. Click the Organization Name to be forwarded to the Detail page. 
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Figure 40. Organization Detail Page 

5.4 In-Line Editing of a Record 

AMIS supports field-level in-line editing from the Detail page. To edit a field using in-line editing: 

1. Move the mouse next to a field’s value, on the right, from the Detail page. A Pencil icon will be 
displayed. The Pencil icon allows you to do in-line editing. 
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Figure 41. In-Line Editing 

 

2. Double click the Pencil icon. The field will become editable. 
3. Edit the field. 
4. Click the Save button to save your changes. 

 

 

NOTE: You will not be able to edit fields that are non-editable. A Lock icon will 
appear instead of the Pencil icon if you move the mouse next to a non-
editable field.  

 

 
Figure 42. Non-Editable Field 

5.5 Delete a Record 

The option to delete a record is displayed in the Detail page or list view, only if a user is allowed to 
delete records.  

1. To delete a record, ensure you are on the Organization Detail page. 
a. Click the Organizations tab. 
b. Click the Organization Name to be forwarded to the Detail page. 

2. Click the Delete button from the Detail page. 
a. A confirmation is displayed in a new window with options to choose OK to delete the 

record or Cancel to cancel the action. 
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Figure 43. Delete Confirmation 

 

3. Click the Cancel button to cancel the action. 
 

 
NOTE: Once a record is deleted, it is deleted forever and cannot be retrieved.  

 

5.6 Use Shortcuts (Navigation/Hover Links) 

At the top of each Detail page, there are shortcut links to related lists. These links are also called 
navigation (or hover) links.  

Move the mouse over a link such as Contacts or Program Profiles.  

 A small window is displayed, showing data from the related list, without the user navigating 
away from the Detail page. 

 These links eliminate the need to scroll down the page. 

 

Figure 44. Navigation/Hover Links 

5.7 View Related Lists of a Record 

Related lists are records from other objects (e.g., Contacts, Program Profiles, etc.) that are related to the 
object (organization) you are viewing. Related lists are also referred to as “Child Records” and the main 
object is referred to as the “Parent Record”. Related lists are displayed at the bottom section of the 
page. 
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1. To access the organization’s related lists: 
a. Click the corresponding navigation/hover link, or 
b. Scroll down the page. 

 

Figure 45. Organization Related Lists (Child Records) 

 

2. From each related list, you can: 
a. Add a new Child Record by clicking the respective New button under a related list. For 

example, clicking the New Contact button allows you to add a contact to the Contacts 
related list. 

b. Update a Child Record by clicking the Edit link next to a record. 
c. Delete a Child Record by clicking the Del link next to a record. 

3. From each related list, you can also add a record to a related list. For example, you can add a 
new attachment to an organization. 

a. Locate the Notes & Attachments related list. 

 

Figure 46. Notes & Attachments Related List 

 

b. Click the Attach File button in the Notes & Attachments related list. 
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Figure 47. Attach File Screen 

c. Click the Browse button and browse your computer to select a file. 
d. Click the Attach File button to attach the file. 
e. Click the Done button. 

The attached file will be displayed under Notes & Attachments. 

6 Update Organization and Program Profiles 
AMIS automatically creates your Organization Profile once your organization is registered. The 
Organization Profile created automatically by AMIS contains partial information; an authorized user 
from the organization must complete all the necessary information.  
 
The first person to register the organization becomes the administrator for the organization’s AMIS 
account and is responsible for assigning permissions to other users to create or update records in their 
organization.  
 
Make sure you are on the Organizations Home page by clicking the Organizations tab. Click on the 
Organization Name link to open the Organization Detail page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



AMIS Training Manual – AE101 
November 2016 

 
 

35 of 59 
 

 

 
Figure 48. Organization Detail Page 

 
In this section, you will learn how to: 

 Update your Organization Profile 

 Understand SAM and Grants.gov integration 

 Add/update contacts 
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 Assign a profile to a contact 

 Add/update Program Profiles 

 Add/update affiliates. 

6.1 Update Your Organization Profile 

To edit the organization detail information: 

1. Click the Edit button. 
Note: If you do not see an Edit button, you may not have the permission to create and edit 
records. Please contact an administrator for your organization’s AMIS account, if you require 
these capabilities. 

 
Figure 49. Organization Edit Page 

2. Enter all the information on the page such as Financial Institution Type, Organization Structure, 
and Address Information, etc. 

3. Click the Save button to save your work and return to the Organization Detail page. 

6.2 SAM and Grants.gov Integration 

SAM Integration – All contractors or entities doing business with the U.S. Federal Government are 
required to register in SAM.gov, the System for Award Management (SAM) website.  AMIS interfaces 
with SAM.gov and automatically validates each organization that registers in AMIS.  
 
Grants.gov Integration – Some CDFI Fund programs (e.g., CDFI Program) require applicants to submit 
their SF-424 program application via Grants.gov. When an organization applies for CDFI Program 
funding, AMIS interfaces with Grants.gov, downloads the SF-424 program application when it is 
submitted, and associates it to the applicant organization.  
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NOTE: Please ensure you enter the accurate EIN and DUNS number for your 
organization in AMIS. 

 

6.3 Add/Update Contacts 

The Contacts related list allows you to add contacts/users to your organization. The contacts/users that 
you add will participate in AMIS by completing the organization’s award information such as 
applications, payment (disbursement) requests, and compliance reports.  
 
From the Organization Detail page, navigate to the Contacts related list. 
 

 
Figure 50. Contacts Related List 

 

1. To add a contact, click the New Contact button. 

 

Figure 51. Contact Edit Page 

2. Complete all the information on the Contact Edit page. 
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3. Click the Save button once you are done. You will be forwarded to the Contact Detail page. 

6.4 Assign a Profile to a Contact (Admin Users only) 

In order for a contact to be able to log in to AMIS as a user and perform work (e.g., complete 
applications and compliance reports), they need to be assigned a profile (permissions) that enables 
them to create and edit records.  
 

 

NOTE: Only an administrator for an organization’s AMIS account can assign a 
profile to other contacts in the organization. 

 
To assign a profile to a contact: 

1. Access the Contacts related list on the Organization Detail page. 

 

Figure 52. Contacts Related List 

2. Click the Contact Name link for a contact you wish to assign a profile e.g., click the name of the 
contact you created above. 

 

Figure 53. Contact Detail Page 

3. From the Contact Detail page, click the Manage External User drop-down menu. 
4. Select the Enable Partner User option to be forwarded to the Manager External User page. 
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Figure 54. Manage External User Page 

 

5. Complete all the required information on the page. 
a. Enter a User Name and Nickname for the contact. 
b. Select User under the Profile field. 
c. Ensure the “Generate new password and notify user immediately” checkbox is selected. 
d. Enter an email address for the contact. 

6. Click the Save button to save your changes. 
7. AMIS will send an email to the contact inviting them to log in to AMIS and create their password. 

6.5 Add/Update Program Profiles 

The Program Profiles related list allows you to add or update your organizational data that is specific to 
a CDFI Fund program from a single area. This section is required in order for you to complete an 
application. AMIS automatically creates a Program Profile, with partial data, for each of the CDFI Fund’s 
programs when the organization is created. Organizations applying for certification or funding programs 
are required to complete the rest of the Program Profile information and specify information such as the 
Applicant Category and Fiscal Year. Scroll down the Organization Detail page to access the Program 
Profiles related list. 
 

 
Figure 55. Program Profiles Related List 

 
To edit a Program Profile: 
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1. From the Organization Detail page, click the Edit link next to a Program Profile record (e.g., click 
the Edit link next to the CDE-CERT Record Type). You will be forwarded to the Program Profile 
Edit page. 

 
Figure 56. Program Profile Edit Page 

2. Complete all the information on the page. 
3. Click the Save button. You will be forwarded to the Organization Detail page. 
4. You are now ready to complete your CDE Certification Application. Scroll down to the Program 

Profile related list. From the Program Profile related list, click the Program Profile Name link 
next to the CDE-CERT Record Type to be forwarded to the CDE Certification Program Profile 
Detail page. 

a. Observe the Certification Applications related list. 
b. To complete a CDE Certification Application, click the New Certification Application 

button. Please refer to the AE102: CDE Certification Application Submission (for CDE 
Certification Applicants) training manual to learn how to complete your application. 

6.6 Add/Update Affiliates 

The CDFI Fund requires regulated institutions to report their affiliates or subsidiary institutions. The 
Affiliates related list allows you to add or update your affiliates.   
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Figure 57.  Affiliates Related List 

To add an affiliate: 

1. From the Affiliates related list, on the Organization Detail page, click the New Affiliates button 
to be forwarded to the Affiliates Edit page. 

 
Figure 58. Affiliates Edit Page 

2. Complete all the information on the page and click the Save button. 

7 Global Search 
Global Search allows users to search all AMIS data elements/fields. It uses search options, search terms, 
and wildcards and operators to refine your search. Just like any search engine, Global Search keeps track 
of your search terms and how often you use them, and arranges the search results accordingly. Search 
results for the objects you use most frequently appear at the top of the list. 
 

 
Figure 59. AMIS Global Search Screen 

 
Wildcards and Boolean operators allow you to refine or search for partially matching terms. 
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7.1 Wildcards 

AMIS allows you to search using the asterisk symbol (*) and question mark symbol (?) as wildcards. 

1. Use the asterisk symbol (*) to match zero or more characters in the middle or end of your 
search term. For example, comp* finds items like “Explanation of Noncompliance” and 
“Compliance Report”; 00* finds items with record IDs that have zeros. Please note that the 
search engine searches only for records within your organization.  

a. Enter 00* and click the Search All button. 

 

Figure 60. Search Results for Search by * Symbol  

b. Search using any other search term or text character of your choice followed by *. 
 

2. Use the question mark symbol (?) to match a single character in the middle or end (not the 
beginning) of your search term. For example, J?n finds names such as Jon and Jen.  

a. Search using ? in between two characters. (In the example below, a search using E?a 
produced the results shown below because Eva Lawyer, a contact at the MCT Federal 
Credit Union, met the E?a search criteria.) 

 

 
Figure 61. Search Results for Search by ? Symbol  

7.2 Boolean Operators 

You can also use Boolean operators, such as AND, OR, AND NOT, ( ) (parentheses), and " " (quotation 
marks) to refine search results. 
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Table 7-1. Operator Descriptions 

Operator Description 

AND Finds items that match all of the search terms. For example, “acme AND 
california” finds items with the word “acme” and the word “california”, 
but not items with only the word “acme”. 
Using AND is optional in most cases, because searching for “acme 
california” is the same as searching for “acme AND california”. If a search 
doesn’t return any results that match all of the terms, the search 
capability looks for matches by using the OR operator. 

OR Finds items with at least one of the search terms. For example, “acme OR 
california” finds items with either “acme” or “california” or both. 

AND NOT Finds items that do not contain the search term. For example, “acme AND 
NOT california” finds items that have the word “acme” but not the 
word “california”. 

() (parentheses) Groups search terms together. Grouped search terms are evaluated 
before other search terms in a character string. For example, “acme AND 
(california OR meeting)” finds items that contain “acme and california” 
and items that contain “acme and meeting”. 

“ “ (quotation 
marks) 

Finds an exact phrase. For example, a search for "monday meeting" finds 
items that contain “monday meeting”, but not items that 
contain “monday afternoon meeting” or “monday's meeting”. 
The asterisk (*) and question mark (?) function as wildcards when 
included in a search phrase that is enclosed in quotation marks or 
when an exact phrase is selected in the search scope. 

 

8 Service Requests 
AMIS has a service request function that allows users to make general inquiries and/or request specific 
changes. This function facilitates smooth communication between external users and CDFI Fund staff. 
Once you submit a service request, it will be reviewed by CDFI Fund staff who will make a determination 
and provide their comments and resolution to the service request. You can track issues or requests that 
you have submitted to the CDFI Fund and their resolutions in a central area. From the Service Requests 
Home page, you can:  

 Submit a change request, such as a modification or amendment to an award  

 Submit a general inquiry, such as a question on an application. 

 

Click the Service Requests tab to be forwarded to the Service Requests Home page. 
 
 
 
 
 
 
 
 

https://help.salesforce.com/apex/HTViewHelpDoc?id=search_unified_wildcards.htm&language=en_US#search_unified_wildcards
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Figure 62. Service Requests Home Page 

8.1 Complete/Submit Change Requests 

To submit a change request: 

1. From the Service Requests Home page, click the Create New Service Request button. 

 

Figure 63. Service Request Record Type Screen 

 
2. Select the Change Request option from the Record Type of New Record drop-down menu and 

click the Continue button. 
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Figure 64. Service Request Edit Page 

3. If the Contact Name field is not populated, enter the person that the CDFI Fund will contact 
about the request. 

a. Click the Lookup icon next to the Contact Name field. 
b. Search for a contact in the organization by entering their name in the Lookup field and 

then clicking the Go! button. 
c. Click on a Contact Name to select it. 

4. Select the service request type from the Type drop-down menu (e.g., select CDE Cert-Service 
Area Amendment). 

 

NOTE: Make sure that you select the appropriate service request type from the 
Type drop-down menu to ensure that your service request is forwarded to the 
appropriate CDFI Fund staff person. 

5. Select the type of change from the Change Type drop-down menu (e.g., Service Area 
Amendment).  

 

NOTE: The Change Type drop-down menu is dependent on the Type drop-down 
menu. It will be disabled until a service request type is selected. 

6. Associate the amendment to the appropriate award by clicking the Lookup icon next to the 
Award field. 

7. Under the Description Information section, enter a subject and description in the corresponding 
fields. 

8. Click the appropriate button at the top of the page. 
a. Click the Submit button to submit the service request to the CDFI Fund and to be 

forwarded to the Service Request Detail page. 
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b. Click the Submit & Add Attachment button to add an attachment and submit the 
service request. 

c. Click the Save & New button to save the record and to create another service request. 
Users should select this option to create several service requests quickly. 

d. Click the Cancel button to exit the Service Request Edit page. 
 

 

Figure 65. Service Request Detail Page 

8.2 Add Attachments  

You can add attachments to a service request from the Service Request Detail page. The Attachments 
related list allows you to add supporting documents to a service request.  

 
Figure 66. Service Request – Attachments Related List 

 
To add an attachment: 

1. Click the Attach File button under the Attachments related list. 
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Figure 67. Attach File Screen 

2. Click the Browse button and select the file to attach. 
3. Click the Attach File button. 
4. Click the Done button to be forwarded back to the Service Request Detail page and to see the 

file attached. 

8.3 Add/View Service Request Comments 

The Service Request Comments related list allows users to provide additional comments to the CDFI 
Fund about a service request after it has been submitted to the appropriate CDFI Fund staff. In addition, 
you can view the comments provided by CDFI Fund staff to address your service request. 
 

 
Figure 68. Service Request Comments Related List 

 
To add comments to the service request: 

1. Click the Add Comment button under Service Request Comments related list. 
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Figure 69. Service Request Comment Details Screen 

2. Enter comments in the Comment field. 
3. Click the Save button to return to the Service Request Detail page. 

8.4 Complete/Submit General Inquiries 

To submit a general inquiry service request: 

1. From the Service Requests Home page, click the Create New Service Request button. 
 

 

Figure 70. Service Request Record Type Screen 

2. Select the General Inquiry option from the Record Type of New Record drop-down menu and 
click the Continue button. 
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Figure 71. Service Request Edit Page 

3. If the Contact Name field is not populated, enter the person that the CDFI Fund will contact 
about the request. 

a. Click the Lookup icon next to the Contact Name field. 
b. Search for a contact in the organization by entering their name in the Lookup field and 

then clicking the Go! button. 
c. Click on a Contact Name to select it. 

4. Select the service request type from the Type drop-down menu (e.g., select CDFI-General 
Question). 

5. Select the service request reason from the Service Request Reason drop-down menu. 
6. Under the Description Information section, enter a subject and description in the corresponding 

fields. 
7. Click the appropriate button at the top of the page. 

a. Click the Submit button to submit the service request to the CDFI Fund and to be 
forwarded to the Service Request Detail page. 

b. Click the Submit & Add Attachment button to add an attachment and submit the 
service request. 

c. Click the Save & New button to save the record and to create another service request. 
Users should select this option to create several service requests quickly. 

d. Click the Cancel button to exit the Service Request Edit page. 

Similar to the change request service request type, you can add additional comments or attachments to 
the general inquiry type of service request by clicking the appropriate button under the Service Request 
Detail page. 
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9 External Contacts 
AMIS has the capability for a user needing access to another organization to request for that access. 
Once access is requested, the administrator for the organization’s AMIS account will review the request 
and take the appropriate action to grant or reject the access.  

9.1 Request Access to an Additional Organization 

 

 

NOTE: You need to be registered as a user in AMIS before you can request 
access to an additional organization. 

 
To request access to an additional organization: 

1. Access the Home tab and then click the Access to Additional Organizations link, on the left 
sidebar menu, under Custom Links. 

 

Figure 72. Home Page – Link to Request Access to Additional Organizations 

2. You will be forwarded to the Organizations tab, to a page where you can search for the 
organization for which you need access. Enter the EIN/TIN# for the organization you wish to 
request access and then click the Search button. 

 

Figure 73. Request Access to Additional Organizations – Search for Organization 
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NOTE: Please ensure you enter the accurate EIN, including any dashes, of the 
organization in which you are requesting access. 

 

3. Under the Organization Results section, locate and select the checkbox next to the name of the 
organization you wish to access. Click the Process Selected button. 

 

Figure 74. Request Access to Additional Organizations – Select Organization 

 

4. A results message will be displayed to confirm your access request. The Admin User of the 
organization will receive an email about your access request. You will also receive an email to 
inform you if your request was granted or rejected. 

 

Figure 75. Request Access to Additional Organizations Results 

9.2 Access Additional Organizations as an External Contact 

Once you receive an email confirming that you have been granted access to an additional organization 
as per your access request, you can access that organization as follows: 

1. From the Organizations tab, select “All Organizations” next to the View drop-down menu and 
click the Go! button. 
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Figure 76. Organization Home 

2. From the organization’s list, locate the new organization and click on its Organization Name link 
to be forwarded to the Organization Detail page. 

 

Figure 77. Organization’s List Page 

 

3. You will be forwarded to the Organization Detail page as per Section 6.1 above. Based upon 
your access control, you can read or edit organization data. 

9.3 Grant Organization Access to an External Contact (Admin Users Only) 

 

 
NOTE: Only the Admin Users can grant access to external contacts. 

 
Admin Users will receive an email when an external contact requests access to their organization.  
To grant organization access to an external contact as an administrator: 

1. From the Organizations tab, locate your organization and click on the Organization Name link to 
open the Organization Detail page. If you cannot see your organization, select “All 
Organizations” next to the View drop-down menu and then click the Go! button. 
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Figure 78. Organizations Home Page 

2. From the Organization Detail page, access the External Contacts related list by clicking the 
External Contacts link.  

 

Figure 79. Organizations Detail Page – External Contacts Link 

 

3. The External Contacts related list displays external contacts for your organization. Access 
Control for each contact is also displayed. To grant or revoke access, locate an external contact 
whose Access Control is “Pending” and click their Edit link. 

 

Figure 80. External Contacts Related List 
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4. From the External Contact Edit page, select an option next to the Access Control drop-down 
menu and then click the Save button. 

 

Figure 81. External Contacts Edit Page 

 

Table 9-1. Access Control Definitions 

 

Access Control Definitions: 

a. Pending – This is the default Access Control assigned by AMIS when an 
external user requests access. The external contact access request in 
this state has not been reviewed by the Admin User. 

b. Rejected – This option should be used to reject an organization access 
request. The rejected user will not be able to access the organization. 

c. Remove – This option should be used to revoke organization access 
originally granted to an external user. The user will not be able to 
access the organization. 

d. Read – This option should be used to grant ‘View’ access to an external 
user. The user will be able to log in to your organization and read all the 
information. 

e. Edit – This option should be used to grant ‘Edit’ access to an external 
user. The user will be able to log in to your organization and edit your 
organization information. 

 

5. You will be forwarded to the External Contact Detail page.  
a. The information you edited should be saved.  
b. The external contact you granted or rejected access will receive an email regarding your 

decision. 
6. Click the Organization link to return to the Organization Detail page. 
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Figure 82. External Contacts Detail Page 

 

7. Repeat steps 2-5 under this section to grant, reject, or revoke access to additional external 
contacts for your organization. 

 

10 Organization Profile, Program Profile, and Application Overview 
(Three-Tiered Design) 

AMIS’s three-tiered design is the foundation of how information is structured in AMIS. This design 
combines information from three objects that are related – the Organization Profile, Program Profile, 
and Application. 

 
 

Figure 83. AMIS’s Three-Tiered Design 
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1. Tier 1 – Organization Profile: This is the top tier in the three-tiered design of AMIS. It has 
common data elements that can be shared across the entire CDFI Fund, regardless of program 
or business unit. These common data elements, which include organization type, certification 
information, address, geographical markets, and lines of business/financial products, are 
displayed on the Organization Profile and are shared across all CDFI Fund programs. In addition, 
applicants, award/allocation recipients, and CDFI Fund staff can get a quick overview of an 
organization by viewing its compliance, awards in other programs, etc.  
 

 

NOTE: An organization must have an Organization Profile set up in AMIS to 
apply for funding. 

 

2. Tier 2 – Program Profile: This is the middle tier in the three-tiered design of AMIS. The Program 
Profile is used to display more detailed organizational data that is specific to a program funding 
round such as financial data, awards, program funding and certification applications.  It supports 
multiple applications, from a single applicant organization, that share information from the 
Program Profile. This structure allows an organization to apply for: 

a. Funding from multiple programs within a funding round (e.g., FY 2015 funding round of 
the CDFI Program and FY 2015 funding round of the NMTC Program). 

b. Multiple funding rounds within a CDFI Fund program (e.g., FY 2014 funding round of the 
BEA Program, FY 2015 funding round of the BEA Program). 

 

 

NOTE: An organization must have a Program Profile for each CDFI Fund 
program to which it applies for funding or certification.  AMIS automatically 
creates the Program Profile and each organization is required to update it 
accordingly. 

 
3. Tier 3 – Application:  This is the lowest level in the three-tiered design of AMIS. For each 

Program Profile, application data (for both certifications and programs) is captured for the 
organization and its unique fiscal funding profile. AMIS automatically copies common data (such 
as Organization Name, EIN, DUNS, and Organization Type) from the Program Profile to the 
application. 
 

 

NOTE: An organization must complete an application to apply for certification 
or a funding program. 

 
The three-tiered design of AMIS prevents redundancy and duplication of information since data is 
entered in one place and shared across the three objects. 
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10.1 AMIS Three-Tiered Design Data Flow 

 
 

Figure 84. AMIS’s Three Tiered Design – Data Flow 

 
An applicant organization to any CDFI Fund program will log in through the AMIS Portal. 

 Organization Profile – The organizational data of the applicant organization will be displayed 
here. The applicant organization will complete common data elements needed by all programs 
here. 

 Program Profile – AMIS creates a Program Profile once an Organization Profile is created. To 
begin the process of applying for certification or program funding, the applicant organization 
selects the appropriate Program Profile. 

 Application – From the Program Profile, the applicant organization will create an application for 
the desired program each fiscal year. 
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11 Appendices 

11.1 Acronyms 

Table 11-1 - Acronyms 

Acronym Definition 

AMIS Awards Management Information System 

BEA Program Bank Enterprise Awards Program 

BFS Bureau of Fiscal Service 

BG Program Bond Guarantee Program 

CDE Community Development Entity 

CDFI Fund Community Development Financial Institutions Fund 

CDFI Program Community Development Financial Institutions Program 

CCME Certification, Compliance Monitoring, and Evaluation  

CIIS Community Investment Impact System 

CIMS3 CDFI Fund Information Mapping System 

CMF Capital Magnet Fund 

COI Conflict of Interest 

FM Financial Management 

LEA  Legislative and External Affairs 

OLC Office of Legal Counsel 

NACA Program Native American CDFI Assistance Program 

NOAA Notice of Allocation Availability 

NOFA Notice of Funds Availability 

NOGA Notice of Guarantee Authority 

NMTC Program New Markets Tax Credit Program 

PM Program Manager 

PMO Project Management Office 
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Acronym Definition 

SAM System for Award Management 

 
 
 


